
 

Designing a flying screaming monkey launcher 
 

 

Using Fusion 360 you will design a device that will hold a stretched flying screaming monkey and release 

it when an integrated gear motor is energized.  The device will be about 22 inches long and at one end 

will have protruding elements to take the place of the two fingers and at the other a release mechanism 

powered by a gear motor.  A CAD model of a monkey and gear motor with cam will be provided.  One will 

note that the CAD monkey model has a loop attached to its feet that the release mechanism will hold.  

The design will be comprised of custom 3D printed elements and off-the-shelf parts. 



 

 

 

Learning objectives: 

- using one's creativity to invent the structure and release mechanism 

- integrating custom designed elements with off-the-shelf parts 

- hand drawing initial design concepts 

- designing the launcher in CAD (monkey and motor models supplied) 

- optimizing 3D printability (limiting the need for supports) 

- (advanced) performing an equivalent circuit analysis for force vs deflection 

- (advanced) performing a FEA (Finite Element Analysis) simulation 

- (advanced) optimizing the design for manufacturability (DFM) 
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Estimating Dimensions from Photos  (You can skip this because a monkey CAD model is provided.) 

We are excited to get going with our design and we don't yet have an actual monkey yet to measure.  We can find a 
photo on the Internet and paste it into a graphics program to determine estimates of dimensions.  Ideally a photo 
should include an item we know the size of, such as a coin, but here we can use the length of a finger. 

 
Here a photo is pasted into Microsoft Paint showing shapes drawn.  As a shape is drawn its dimensions will be 
shown in the box at the bottom as 274 x 41px is for the body rectangle. One may have to use the View tab and 
check Status bar to view dimensions.  A circle was drawn so that its diameter equals the finger length and two 
rectangles were drawn for the stretched arm length and body length.  Microsoft Paint is included with Windows.  
For Macs one can use its included Preview software. 

 mid finger length = √672 + 542  = 86px      we want the diagonal of the 67 x 54px box 

 my finger = 3.1" 3.1"/86px = 0.036 (inches per pixel) 

 monkey arm length = 186px                     186 x 0.036 = 6.7" 

 monkey body length = 277px                    277 x 0.036 = 10.0"  

Shape dimensions 

Use the View tab and 
check Status bar to 
show dimensions 



 

Monkey Stretch Testing and Analysis 

Mr. Barbetta's Flying Screaming Animal Testing Lab 

No flying screaming animals are ever harmed in this lab. 
 

 

Unstretched monkey with 18" ruler 

 

 

Stretched monkey with 18" ruler 

Scale now reads   0.00 lbs 
monkey is un-stretched 

Scale now reads   5.90 lbs 
monkey is stretched 7" 

7.2" 



 

Monkey Stretch Data Analysis (This can be skipped, but it does show the force needed to stretch the monkey.) 

 

As the monkey was stretched, the force was recorded and the data was entered into Excel.  It can be helpful to create a mathematical 

model of a flying screaming animal characteristic. 

First a straight line fit was performed using the Excel "Trendline" feature and enabling the showing of the equation.  The R2 option was also 

enabled to quantify the fit of the line or curve.  One would think a straight line would provide the best fit for the stretching to act as a spring 

with its spring constant (k) equaling the slope of the line.  It's interesting that a parabolic curve with a decreasing slope offers a better fit, 

however, the linear fit with a slope of 0.788 lbs/in will suffice.  For each inch of stretch the force should increase by 0.788 pounds. 

We can see that as long as the monkey stretch doesn't exceed 8 inches our stretching force should remain under 7 pounds.  For a good 

safety margin we should insure our launcher can withstand 10 pounds of force. 

It would be interesting to test several flying screaming monkeys to investigate manufacturing variablilities. 

Is there an ISO or ASME standard for flying screaming monkey characteristics? 



 

Monkey Stretch Energy Analysis using Calculus 

 

  

 

 

 

 

 

 

  

  

To determine our monkey's potential energy when stretched we can integrate 
over the monkey's change in length.  KM is the spring constant of the monkey. 

If the force to stretch relationship were linear, as with an ideal spring, the 
integration would evaluate to this equation. 

In Mr. Barbetta's Flying Screaming Animal Testing Lab it was found that the relationship had a non-linear 
relationship and a 2nd order polynomial provided a nice fit.  We have to follow through with integration. 

It's not that bad.  We can split this into three integrations and then play with the exponents.  It's nice that 
onelimit of integration is 0 so we only have to evaluate for our stretch amount of 8 in. 



 

Incorporating Off-The-Shelf Components 

 

Here is a simplified side-view diagram of the monkey and its launcher.  At one end is a structure that takes the place of 

ones fingers that would fit into pockets on the hands of the monkey.  The hands of the monkey are first hooked onto 

this structure. 

The monkey is then stretched manually and the loop is attched to the monkey's feet is attached to a "release 

mechanism".  The gear motor is part of the release end.  When the gear motor is powered and its shaft turns, the loop 

is released and the monkey's stretched arms propels the monkey forward and away from the launcher.  The gear 

motor is only used to release the monkey and not stretch it. 

Designing the launcher, represented by the blue blocks, so that the entire launcher will be 3D printed, will require a 

great deal of 3D printing.  The printing will take many hours and will use a lot of filiment.  The launcher must be at least 

22 inches long and withstand over 7 pounds of force.  A fully 3D printed plastic structure will bend easily. 

In order to make manufacturing feasible, the amount of 3D printing must be minimized.  A cheap and easily obtainable 

"off-the'shelf" part or parts could be used for the majority of the launcher's length with the 3D printed parts attached 

at each end.  Examples of "off-the-shelf" parts can include a length of wood, wooden dowel, pipe, metal bar or rod, 

threaded metal rod, etc.  The latter pages of this document show such materials that can be purchased from an 

industrial supplier or Home Depot. 

You will be drawing these off-the-shelf parts in CAD as part of your design, but they will be very simple. 



 

Design Breakdown 
 

 

 

 

 

 

 

  

pocket under 
monkey hand 

Ruler shows inches 

Monkey hand supports 

One task is to design the stationary structure that the 
monkey hands will slip on to, which will take the place of 
the two human fingures that would be inserted into these 
pockets. 

 

Release mechanism 

This task will require the most creativity and concerns the 
design of a movable release element, its linkage to the gear 
motor shaft, perhaps with additional movable elements, 
and the associated support structure .  The following pages 
show details for the gear motor. 

When the gear motor is powered the release element will 
move in such a way that the loop will be released. 

It's best to brainstorm and start hand sketching some ideas.  
There are many methods to design this mechanism. 

To get some ideas one can perform a Google image search 
on    rotational to linear motion   or    mechanical linkage   
or    mechanical cam. 

loop on 
monkey's feet 



 

Gear Motor Information 

 

 

 

 

Here is a close up view of the gear motor (yellow) with a 
Cam (white) on its shaft (yellow).  When the motor is 
powered the shaft will turn and the cam will turn with 
it.  The extended section of the cam is called a lobe and 
it can push on or move a part in your design. 

This cam will be a 3D printed part and you can use it as 
is, modify it, or create your own. 

When powered with 5V the shaft will spin at 180 RPM (3 
rotations per second), but it will slow down "under 
load".  This means that it will spin more slowly when the 
cam is pushing against something.  The term "gear 
motor" is used because inside the yellow box are gears 
to slow down the high rotational speed of the motor.  
More importantly this provides greater "torque" 
(rotational force) from the shaft.  However, as torque is 
increased the speed will slow down until the motor 
"stalls".  This is a cheap and fairly weak gear motor.  You 
would be able to stop the cam by holding it.  When the 
motor isn't powered you can also turn the cam by hand.  
One may do this to set an initial cam position. 

There are two mounting holes with an inner diameter of 
0.120".  Two 4-40 1" long machine screws can pass 
through the gear motor and a part you design to hold 
the gear motor in place.  Two 4-40 nuts on the screws 
will allow them to be tightened. 

These are nice cheap gear motors for projects.  They are 
available from many sellers.  Here's a listing to buy 
these gear motors for $2 a piece.  If you need more 
powerful gear motors there are more expensive ones on 
Amazon. 

shaft 
mounting holes for 

4-40 machine screws 
 

cam 



 

Gear Motor Torque Analysis 
 

 

 

 

 

 

 

 

 

 

  

Gear motor with 3d printed 1" diameter pulley 

Variable power supply 

Bag of AA batteries 
Batteries are added or removed 
to achieve various weights 

 Mr. Barbetta's gear motor testing lab 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Unpowered Hold Torque and Force 

One test determined the amount of torque 
needed to overcome any static friction to 
cause the shaft to turn.  This demonstrates 
that one can't simply have to cam hold the 
loop and then release it upon powering the 
motor.  The shaft would turn too easily. 

Powered Starting Torque and Force 

The tests reveal a torque of about 0.8 in lb 
when the gear motor is powered with 5V. 

The blue element represents a movable part 
that the cam is pushing and on it is a red 
arrow representing the force imparted on it 
by the cam.  The cam can also pull on a 
movable part with the same force. 

The two pictures illustrate how the force is 
related to the length of the cam. 



 

System Circuit Model (Advanced) 

 

 

The top diagram represents how the force to stretch the monkey will cause a deformation of the 

launcher, which we wish to minimize.  We can create a simplified spring model and an equivalent 

electrical circuit model to calculate the deformation of the launcher. 

 

 



 

FEA (Finite Element Analysis) of the Launcher (Advanced) 

We can extend our simple equivalent circuit analysis to a static stress simulation in Fusion 360 or 

Inventor.  Below are screen shots from Fusion 360 for doing so with a simplified launcher structure.  You 

will be using the elements you designed including any off-the-shelf parts.  You need not include movable 

elements of your design.  For example, the force from the loop at the monkey's feet can be applied to an 

equivalent stationary point. 

In the below simulation a constraint is set on the structure at the monkey's hands.  The results for both 

displacement and stress are shown. 

 

 



 

Optimizing 3D Printability   (eliminating the need for supports) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

This protrusion supports the thin 

(0.015") plastic (polycarbonate) shield.  

It is at the bottom of the frame so that 

it sits on the build plate and is thus not 

an overhang.   To approximate a 

rounded form chamfers are added to 

the bottom.  The chamfer angles are 45 

degrees to avoid the need for supports. 

There are other bottom chamfer 

angles of 45 degrees to avoid the 

need for supports.  

This protrusion supports 

the rubber strap.  It 's 

chamfer angles are 45 

degrees to avoid the 

need for supports. 

The tops of these holes are only 

0.230" wide and thus, this "bridge" 

doesn't need supports. 

"Overhang Rule":  If an overhang is 45 degrees or steeper, supports are not needed. 

 



 

Opening the CAD Fusion Starting Project 

 

Download the "MonkeyWithGearMotor.f3d" file from Schoology and then using Open from the File menu click on "Open from my 

computer" and navigate to the location you downloaded the file to, ie "Downloads" folder.  Note that by default Fusion 360 saves and 

opens files from their "cloud", however, you can select "Export" when saving and "Open from my computer" when opening if you wish 

to keep files on your computer. 

 



 

The "MonkeyWithGearMotor-Rev1.f3d" starting project 

 

Here is the starting project with our monkey (in its stretched state) and a gear motor, which you can see as components circled in the 

Browser.  Example mechanical mechanisms and off-the-shelf compnents are also included.  The page titled "CAD File Mechanism Example 

Components" discusses these components.  When the gear motor is powered the monkey will be released to begin its flying screaming 

journey.  Note the loop through the feet of the monkey, which a part can hold and then release.  Another aspect of the design is a part that 

takes the place of the fingers.   

Gear Motor 
 
Release Loop 

 



 

Moving your monkey and gear motor 

 

As you work on your design you will need to move and/or rotate your monkey and gear motor at times.  Because they are 

"Components" you can select "Monkey" or "GearMotor" on the left, right-click, and select "MoveCopy".  Here we do so for the 

GearMotor.  See next page. 

 



 

Moving the gear motor 

 

After selecting "Move/Copy", as shown on the previous page, arrows and arcs will appear around the component and a "Move/Copy" 

window will open.  You can use the arrows to move the component or the arcs to rotate the component and then click "OK".  You can 

also enter corresponding distances and/or angles in the boxes.  If we had selected the monkey, these arrows and arcs would appear 

around the monkey. 

 



 

Starting to sketch 

 

At any time, before or after moving components, you can create a sketch to extrude into a body.  After clicking on the top "Sketch" 

icon, you have to choose a plane or surface.  Here, the surface of the gear motor was selected.  This is one possible place to start 

because you will be designing a part that the motor will attach to. 

 



 

CAD File Mechanism Example Components     (in file "MonkeyWithGearMotor Rev1.f3d") 

The file "MonkeyWithGearMotor Rev1.f3d" contains example mechanism components 

 

Slider/Pivot 
Both sildes and pivots 

 

Slider 
Slides up and down 

 
Pivot 

Turns on boss 

 

Cam 
Turns with shaft 

 
Cam Long 

Cam Snail 

Linkage 
Blue arm moves 

with shaft 

Gear Motor Mount 

Components can be hidden by clicking on the eye icon near their names 

 
These example components are 3D printable and can be modified by pulling their 
faces.  The Sliders and Pivots show how cylinders (bosses) or guides can be 
extruded from the Gear Motor Mount.  There are also various cams and a linkage 
that can be moved over to the gear motor shaft. 

 



 

Off-the-Shelf Part Examples 
The following pages show some examples of parts that can be incoporated into your design.  You are not restricted to these parts.  

You can use other parts if you wish. 

McMaster-Carr (mcmaster.com)  6061 Aluminum bars 

 



 

McMaster-Carr (mcmaster.com)  Steel Threaded Rod 

 
 



 

McMaster-Carr (mcmaster.com)  Threaded Steel Pipe 

 

 

Pipe sizes can be a little crazy.  Here 
it is shown that a 1/8" pipe has a 
0.405" outer diameter.  This would 
be rigid enough for our needs. 



 

Home Depot  Wood 

A 2x4 piece of lumber would be overkill for us.  Consider something like a 1x2.  We can make 

a few launchers from this 8 foot piece of wood. 

 



 

Home Depot  Wooden Dowel 

 

 

 

 

 



 

Home Depot  1/2" Electrical Conduit (Outer Diameter = 0.706", Inner Diameter = 0.622") 

 

 

 



 

Home Depot Shelving Standards 

 

 


